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      แบบสอบถาม 

ความรู้ความเข้าใจของบุคลากรด้านงานงบประมาณ พสัดุ การเงินและบัญชีต่อ 

ระบบวางแผนทรัพยากรองค์กรของมหาวทิยาลยัเทคโนโลยรีาชมงคลล้านนา 

…………………………………………………………….………………………………… 

ค าช้ีแจง  แบบสอบถามน้ีจัดท าข้ึนเพื่อใช้เป็นข้อมูลประกอบการศึกษาค้นคว้าอิสระตาม

หลกัสูตรปริญญาโทการบญัชี คณะบริหารธุรกิจ มหาวิทยาลยัเชียงใหม่ โดยแบบสอบถามไดแ้บ่ง

ออก 3 ส่วน ดงัน้ี 

 ส่วนที ่1  ขอ้มูลทัว่ไปของผูต้อบแบบสอบถามและขอ้มูลเก่ียวกบัประโยชน์และ 
ความยุง่ยากซบัซอ้นของระบบวางแผนทรัพยากรองคก์รของ 
มหาวทิยาลยัเทคโนโลยรีาชมงคลลา้นนา 

 ส่วนที ่2   ขอ้มูลเก่ียวกบัความรู้ความเขา้ใจของบุคลากรดา้นงบประมาณ พสัดุ     

    การเงิน และบญัชีต่อระบบวางแผนทรัพยากรองคก์รของมหาวทิยาลยั 

   เทคโนโลยรีาชมงคลลา้นนา 

 ส่วนที ่3   ขอ้มูลเก่ียวกบัปัญหาและขอ้เสนอแนะของบุคลากรดา้นงบประมาณ พสัดุ      

             การเงินและบญัชีต่อระบบวางแผนทรัพยากรองคก์รของมหาวทิยาลยั 

   เทคโนโลยรีาชมงคลลา้นนา 

 

 ขอ้มูลท่ีได้รับน้ีจะน าไปใช้ประโยชน์ในการศึกษา จึงใคร่ขอความกรุณาจากท่าน

โปรดให้ข้อมูลในแบบสอบถามน้ีตามความจริง และเป็นความคิดเห็นของท่าน พร้อมทั้ ง

ขอขอบพระคุณในความร่วมมือท่ีไดรั้บจากท่านมา ณ โอกาสน้ีดว้ย 

 

 

                                                                                      นางสาวขวญัเรือน  พิศเพง็ 

 นกัศึกษาปริญญาโทการบญัชี มหาวทิยาลยัเชียงใหม่ 
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ส่วนที่ 1  ขอ้มูลทัว่ไปของผูต้อบแบบสอบถามและขอ้มูลเก่ียวกบัประโยชน์และความ
ยุง่ยากซบัซอ้นของระบบวางแผนทรัพยากรองคก์รของมหาวทิยาลยัเทคโนโลยี
ราชมงคลลา้นนา 

 

ค าช้ีแจง  โปรดท าเคร่ืองหมาย    ในช่อง   (   )  หนา้ขอ้ความท่ีท่านเห็นดว้ยในหวัขอ้            

       ต่างๆ หรือเติมขอ้ความลงในช่องวา่งท่ีก าหนดไว ้ 

 
1. เพศ 

(   ) 1.ชาย     (   )  2. หญิง 

2. อาย ุ
(   ) 1.  ต ่ากวา่ 30 ปี    (   )  2.  31 - 40  ปี 

(   ) 3.  41 - 50 ปี    (   )  4.  51 - 60  ปี 

3. ระดบัการศึกษา 
(   )  1. ปวช.     (   )  2.ปวส., อนุปริญญา 

(   )  3. ปริญญาตรี    (   )  4. สูงกวา่ระดบัปริญญาตรี 

4. สาขาวชิาท่ีจบการศึกษา 
(   )  1.  การบญัชี    (   ) 2. บริหารธุรกิจ 

(   )  3.  คอมพิวเตอร์                              (   ) 4. อ่ืนๆ  โปรดระบุ.......... 

5. สถานภาพการเป็นบุคลากรสังกดัมหาวทิยาลยัเทคโนโลยรีาชมงคลลา้นนา 
(   )  1.  ขา้ราชการ    (   ) 2. ลูกจา้งประจ า 

(   )  3.  พนกังานราชการ   (   ) 4. พนกังานมหาวทิยาลยั                                     

(   )  5.  พนกังานตามพนัธกิจ      
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6. หน่วยงานท่ีสังกดั 
(   )  1.  ส่วนกลาง มทร.ลา้นนา  

(ส านกังานอธิการบดี มหาวทิยาลยัเทคโนโลยรีาชมงคลลา้นนา)   

(   )  2.  เขตพื้นท่ี ภาคพายพั เชียงใหม่ 

(   )  3.  เขตพื้นท่ี ล าปาง 

(   )  4.  สวก.ล าปาง (สถาบนัวจิยัเทคโนโลยเีกษตร)     

(   )  5.  เขตพื้นท่ี น่าน 

(   )  6.  เขตพื้นท่ี เชียงราย 

(   )  7.  เขตพื้นท่ี ตาก     

(   )  8.  เขตพื้นท่ี พิษณุโลก 

7. ท่านปฏิบติัหนา้ท่ีดา้นงานงบประมาณ พสัดุ การเงินและบญัชีมาแลว้ก่ีปี 
(   )  1.  ต ่ากวา่ 1 ปี     (   ) 2.  1 - 5 ปี 

(   )  3.  6 - 10 ปี                                       (   ) 4.  11 - 15 ปี 

(   )  5.  16 - 20 ปี     (   ) 6.  20  ปีข้ึนไป 

8. ท่านไดรั้บการแต่งตั้งเป็นผูแ้ทนการเปล่ียนแปลง (Change Agent) ในระบบวางแผน
ทรัพยากรองคก์รของมหาวทิยาลยัเทคโนโลยรีาชมงคลลา้นนาหรือไม่ 
 (   )  1.  ใช่      (   )  2.  ไม่ใช่ 

9. ท่านคิดวา่ระบบวางแผนทรัพยากรองคก์รของมหาวทิยาลยัเทคโนโลยรีาชมงคล
ลา้นนามีประโยชน์มากนอ้ยเพียงใด 
(   )  1. นอ้ยท่ีสุด     (   )  2. นอ้ย 

(   )  3. ปานกลาง     (   )  4. มาก 

(   )  5. มากท่ีสุด 

10. ท่านคิดวา่การใชง้านในระบบวางแผนทรัพยากรองคก์รของมหาวทิยาลยัเทคโนโลยี
ราชมงคลลา้นนา มีความยุง่ยาก ซบัซอ้น ในระดบัใด 
(   )  1. นอ้ยท่ีสุด     (   )  2. นอ้ย 

(   )  3. ปานกลาง     (   )  4. มาก 

(   )  5. มากท่ีสุด 
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11. ท่านปฏิบติังานหรือมีหนา้ท่ีปฏิบติังานในระบบงานยอ่ยในระบบวางแผนทรัพยากร
องคก์รของมหาวทิยาลยัเทคโนโลยรีาชมงคลลา้นนาในระบบใด (สามารถเลือกได้
มากกวา่ 1 ขอ้) 
(   )  1. ระบบงบประมาณ 

(   )  2. ระบบจดัซ้ือจดัจา้ง 

(   )  3. ระบบรายรับและออกใบเสร็จ 

(   )  4. ระบบบญัชีเจา้หน้ี 

(   )  5. ระบบสินทรัพยถ์าวร 

(   )  6. ระบบบญัชีแยกประเภททัว่ไป 

(   )  7. ระบบบริหารคลงัวสัดุ 

(   )  8. ระบบกระแสเงินสด 

(   )  9. ระบบรายงานผูบ้ริหาร 
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กรุณาตอบตามระบบงานที่ท่านเลอืกในส่วนที่ 1 ข้อ 11 

ส่วนที ่2  ขอ้มูลเก่ียวกบัความรู้ความเขา้ใจต่อระบบวางแผนทรัพยากรองคก์ร 

ค าช้ีแจง  โปรดท าเคร่ืองหมาย    ในช่องค าตอบท่ีตรงความคิดเห็นของท่าน 

 

ขอ้ 
1. ระบบงบประมาณ ใช่ ไม่ 

ใช่ 

ไม่ 

แน่ใจ 

1 โครงสร้างหลกัตามมิติโครงสร้างเพ่ือการบริหาร ประกอบดว้ยมิติหน่วยงาน มิติจงัหวดั 

มิติการเงินและบญัชี 

   

2 การเปิดงวดปีงบประมาณ (Period)  ใชห้นา้จอ Management>Calendar >Open/Close 

Period 

   

3 ในขั้นตอนการสร้างกลุ่มรหสังบประมาณ ในช่อง Boundary  ซ่ึงเป็นการก าหนด

จุดส้ินสุดของช่วงการตรวจสอบงบประมาณ ให้ก าหนดเป็น Quarter เท่านั้น 

   

4 วิธีการตรวจสอบงบประมาณแบบ Absolute เป็นวิธีการตรวจสอบแบบไม่อนุญาตให้

ผา่นรายการ ถา้หากวงเงินไม่พอ 

   

5  เม่ือตอ้งการบนัทึกจดัสรรงบประมาณจะตอ้งใชห้นา้จอ Budget>Journals ในการ

ท างาน 

   

6 ในขั้นตอนการตรวจสอบรายการจดัสรรงบประมาณ กรณีท่ีตอ้งการคน้หารายการ การ

จดัสรรงบประมาณท่ีมาจากการจดัสรรงบประมาณโดยตรง ให้ระบุเง่ือนไขในช่อง 

Source เป็น Budget Requisition  

   

7 ผูใ้ชง้านสามารถติดตามการใชง้บประมาณแบบ online โดยใชห้นา้จอ Fund Available 

Inquiry 

   

8 ผูใ้ชง้านสามารถเรียกดูรายงานจากระบบงบประมาณ เพื่อตรวจสอบงบประมาณ

หลงัจากท ารายการต่างๆ ในระบบไดท้นัที โดยไม่จ าเป็นตอ้งผา่นรายการ (Posting) จาก

ระบบงบประมาณไปยงัระบบบญัชีแยกประเภททัว่ไปแต่อยา่งใด 

   

9  ระบบมีการจดัเก็บขอ้มูลการแกไ้ข โอนยา้ยงบประมาณส าหรับการตรวจสอบยอ้นหลงั    

10 การโอนยา้ยงบประมาณสามารถโอนขา้มกลุ่มงบประมาณได ้แต่ตอ้งเป็นการโอน

ระหวา่งปีงบประมาณเท่านั้น 

   

11  ถา้ตอ้งการสร้างรายงานงบประมาณเอง นอกเหนือจากรูปแบบรายงานมาตรฐานท่ี

ปรากฏในระบบ สามารถสร้างไดโ้ดยใชเ้คร่ืองมือ FSG Report ในระบบตวัจดัการ 

   

12 รายงานท่ีแสดงใน FSG Report จะตอ้งเป็นรายการขอ้มูลท่ีผา่นรายการ (Posting)  ใน

ระบบบญัชีแยกประเภททัว่ไปแลว้ 
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ขอ้ 
2. ระบบจดัซ้ือจดัจ้าง ใช่ ไม่ 

ใช่ 

ไม่ 

แน่ใจ 

1 ในการสร้างขอ้มูลผูข้าย ตอ้งสร้างขอ้มูลเพียง 1 ส่วน คือ Supplier Header     

2 ในกรณีท่ีมีขอ้มูลผูข้ายในระบบท่ีไม่ไดใ้ชแ้ลว้ ใหล้บ (Delete) ขอ้มูลออกจากระบบได้

เลย 

   

3 ในการจดัท าใบขออนุมติัซ้ือ/จา้ง จะตอ้งเลือก Distribution type เป็น Inventory    

4 การขออนุมติัซ้ือ/จา้ง ผูใ้ชง้านจากหน่วยงานท่ีบนัทึกใบขออนุมติัซ้ือ/จา้ง จะตอ้งส่ง

ขอ้มูลไปท่ีฝ่ายพสัดุประจ าหน่วยเบิกจ่าย เพ่ือท าการรับรองความถูกตอ้ง ก่อนท าการ

ออกเอกสารใบขออนุมติัซ้ือ/จา้งออกจากระบบ ให้ผูมี้อ  านาจลงนามอนุมติั  

   

5 ในการคน้หาใบขออนุมติัซ้ือ/จา้งเพ่ือสร้างใบสัง่ซ้ือสัง่จา้ง ผูใ้ชง้านสามารถระบุ

เง่ือนไขเลขท่ีใบขออนุมติัซ้ือ/จา้งในการคน้หาได ้

   

6 ในการเลือกรายการเพ่ือสร้างใบสัง่ซ้ือสัง่จา้ง ผูใ้ชส้ามารถเลือกใบขออนุมติัซ้ือ/จา้งไดเ้พียง 1 

รายการ ต่อการสร้างใบสัง่ซ้ือสั่งจา้ง 1 ใบเท่านั้น 

   

7  เม่ือตอ้งการตรวจสอบงบประมาณ เพ่ือท าการสั่งซ้ือสั่งจา้ง ตอ้งท าการคน้หารายการ

สัง่ซ้ือสัง่จา้งก่อน แลว้เลือกเมนู Tool >Check Fund 

   

8 การตรวจสอบงบประมาณท่ีถูกจองงบไว ้ตอ้งเลือกเมนู Fund Available Inquiry    

9 สถานะ การขออนุมติัเอกสารบนระบบจดัซ้ือจดัจา้งเป็น Approve  แสดงวา่เอกสาร

ไดรั้บอนุมติัสมบูรณ์เรียบร้อยแลว้ 

   

10 ก่อนท าการอนุมติัเอกสารหรือใบสัง่ซ้ือสัง่จา้ง ตอ้งท าการตรวจงบประมาณเสมอ    

11 เอกสารขออนุมติัซ้ือ/จา้งท่ียงัไม่ไดรั้บการอนุมติั หรือแสดงสถานะเป็น Incomplete 

สามารถแกไ้ขได ้โดยให้ท  าการคน้หารายการขออนุมติัซ้ือ/จา้ง แลว้แกไ้ขขอ้มูลท่ี

ตอ้งการ 

   

12 การยกเลิกใบขออนุมติัซ้ือ/จา้งหรือใบสัง่ซ้ือสัง่จา้ง สามารถยกเลิกไดเ้ฉพาะรายการท่ีมีสถานะ 

Incomplete  เท่านั้น 

   

13  การยกเลิกเอกสารตอ้งระบุเหตุผลในการยกเลิกรายการท่ี Reason ก่อน แลว้จึงกดปุ่ ม 

OK 

   

14 การตรวจสอบประวติัของเอกสาร ตอ้งเลือกเอกสารท่ีตอ้งการตรวจสอบประวติัการท า

รายการ แลว้ไปท่ีรายการ Tools>View action History 

   

15 ประวติัของการท ารายการเอกสารแสดงเป็น Performed By.... แสดงถึงผูถื้อครอง

เอกสารล่าสุด ซ่ึงแสดงวา่เอกสารอยูท่ี่ผูใ้ชค้นนั้น และผูใ้ชอ่ื้นจะไม่สามารถเขา้ดู

เอกสารได ้

   

16 เลขท่ีรายงานใบขออนุมติัซ้ือ/จา้งเป็นเลขท่ีท่ีผูใ้ชง้านตอ้งก าหนดเอง    
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ขอ้ 
3. ระบบรายรับและออกใบเสร็จ ใช่ ไม่

ใช่ 

ไม่

แน่ใจ 

1 ขอ้มูลท่ีจะใชใ้นการพิมพใ์บเสร็จ ท่ีผูใ้ชง้านตอ้งจดัเตรียมเบ้ืองตน้ ประกอบดว้ย

ขอ้มูลเลขท่ีใบเสร็จ รายละเอียดบนใบเสร็จ ขอ้มูลลูกหน้ี/นกัศึกษา 

   

2 ในขั้นตอนการก าหนดเลขท่ีใบเสร็จ เม่ือท าการก าหนดเลขท่ีใบเสร็จ และระบุ

รายละเอียดในแต่ละช่องรายการแลว้ แต่ไม่ไดร้ะบุเคร่ืองหมาย √  ท่ีช่อง Enable 

จะไม่สามารถใชเ้ลขท่ีใบเสร็จดงักล่าวได ้

   

3 Cash Account ท่ีหนา้จอรายละเอียดใบเสร็จรับเงิน หมายถึง รหสับญัชีท่ีรับเป็นเงิน

สด/เช็ค/ธนาณติั/เงินโอน 

   

4 (1) การสร้างชุดใบเสร็จ ผูใ้ชง้านสามารถท าการคดัลอกรายการในใบเสร็จรับเงินท่ีเคย
สร้างแลว้ เพ่ือน าไปสร้างรายการใบเสร็จชุดใหม่ได ้

   

5 (1) การน าเขา้ขอ้มูลลูกหน้ี/นกัศึกษา สามารถท ารายการไดท่ี้หนา้จอขอ้มูลหลกั 
ใบเสร็จรับเงิน>ขอ้มูลลูกหน้ี/นกัศึกษา 

   

6 ขอ้มูลนกัศึกษาท่ีจะน าเขา้ (Import) ระบบ จะตอ้งบนัทึกเป็นไฟล ์.CSV เท่านั้น    

7 (1) การคน้หารายการเลขท่ีใบเสร็จท่ีออกไปแลว้ได ้จะสามารถท าไดเ้ฉพาะขอ้มูลท่ียงั
ไม่ท าการส่งขอ้มูลรายการบญัชีไปยงัระบบบญัชีแยกประเภททัว่ไปเท่านั้น  

   

8 ผูใ้ชง้านสามารถเรียกรายงานดูไดว้า่รายช่ือนกัศึกษาใดบา้งท่ีมีการออก

ใบเสร็จรับเงินเรียบร้อยแลว้ 

   

9 (2) ผูใ้ชง้านสามารถท าการยกเลิกรายการท่ีออกใบเสร็จแลว้ได ้โดยการยกเลิกรายการ
นั้นๆ ไม่มีผลกระทบแต่อยา่งใด 

   

10 ผูใ้ชง้านสามารถส่งขอ้มูลรายการทางบญัชีจากระบบรายรับและออกใบเสร็จไปยงั

ระบบบญัชีแยกประเภททัว่ไป โดยการกดปุ่ ม View Request  

   

11 รายงานทุกประเภทจะมีวิธีการออกรายงานท่ีเหมือนกนั ทั้งน้ีผูใ้ชง้านสามารถเลือก

ประเภทรายงาน ก าหนดเง่ือนไขหรือรายะเอียดท่ีตอ้งการในแต่ละรายงานได ้

   

12 หลงัจากส่งรายการค าสั่ง(Submit)เพื่อออกรายงานไปแลว้ และหนา้จอแสดงขอ้มูล

ในช่อง Phase = Pending และ Status = Normal หมายความวา่ ระบบก าลงัรอสร้าง

รายงานอยู ่และมีสถานะของรายการท่ีร้องขอเป็นปกติ แสดงให้ทราบวา่ระบบ

สามารถออกรายงานตามรายการค าสั่งได ้

   

13 รายงานท่ีประมวลผลเสร็จเรียบร้อยสมบูรณ์ จะมี Phase = Complete  และ Status = 

Normal  
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ขอ้ 
4. ระบบบัญชีเจ้าหนี ้ ใช่ ไม่ 

ใช่ 

ไม่

แน่ใจ 

1 เม่ือตอ้งการท ารายการใบขอเบิก ท่ีอา้งใบสัง่ซ้ือ (ไม่ไดเ้ป็นการตั้งหน้ีโดยตรง) สามารถท าไดโ้ดยการเขา้

เมนูหนา้จอกลุ่มการท ารายการขอเบิก 

   

2 เลขท่ีใบส าคญัของใบเบิก ไดม้าโดยการกดปุ่ ม Distributions ท่ีหนา้จอ Invoice    

3 ระบบสามารถท าการค านวณภาษีท่ีเก่ียวขอ้งไดอ้ตัโนมติั    

4 การบนัทึกใบขอเบิกโดยตรงเป็นการบนัทึกใบขอเบิกท่ีไม่ได้มาจากการ Matching จากระบบจดัซ้ือจดัจา้ง    

5 การบนัทึกใบขอเบิกโดยตรง ผูใ้ชง้านในระบบจะตอ้งก าหนดเลขท่ีใบส าคญัของใบขอเบิกทุกคร้ัง    

6 การบนัทึกใบขอเบิก ถา้ Invoice Status เป็น Never Validate แสดงวา่ใบขอเบิกยงัไม่ผา่นการยนืยนัการ

ตรวจสอบ  จะมีผลท าให้ไม่สามารถท าการจ่ายช าระและผา่นขอ้มูลไปยงัระบบบญัชีแยกประเภททัว่ไปได ้

   

7 การคน้หาใบขอเบิก สามารถท าไดโ้ดยเขา้สู่หนา้จอเมนู Invoice>Entry>Invoice    

8 ผูใ้ชง้านสามารถแกไ้ขรายการใบขอเบิกในส่วนรายละเอียดใบขอเบิก (Distributions Line)     

9 ผูใ้ชง้านสามารถยกเลิกใบขอเบิกได ้เฉพาะกรณีท่ีใบขอเบิกนั้นยงัไม่ผา่นรายการบญัชี (Post) เท่านั้น    

10 เม่ือตอ้งการเลือกใบแจง้หน้ี/ใบขอเบิก เพ่ือท าการจ่ายช าระ ตอ้งกดปุ่ ม Enter>Adjust Invoice ท่ีหนา้จอ 

Payment 

   

11 ในขั้นตอนการจ่ายช าระเงิน  ผูใ้ชง้านไม่สามารถท ารายการจ่ายช าระเพียงบางส่วนของจ านวนเตม็ในใบ

ขอเบิกได ้

   

12 ผูใ้ชง้านสามารถยกเลิกรายการจ่ายช าระในระบบไดไ้ม่วา่รายการช าระนั้นจะถูกสร้างรายการบญัชี  

(Create Accounting)  หรือผา่นรายการบญัชี (Post) ไปแลว้ 

   

13 การบนัทึกตั้งเงินยมื/เงินทดรอง จะมี Type เป็น Prepayment    

14 การบนัทึกตั้งเงินยมื/เงินทดรอง เม่ือเขา้สู่หนา้จอ การกรอกขอ้มูลในส่วน Invoice Header ในช่องสาขา  

ซ่ึงระบุท่ีอยูข่องบุคลากร ระบบจะก าหนดให้อตัโนมติั เป็น HOME 

   

15 การจ่ายเงินยมืจะท าไดเ้ม่ือใบตั้งเบิกเงินยมืถูกตรวจสอบรายการ (Invoice Validation) และถูกสร้างรายการ

บญัชีแลว้ (Create Accounting) 

   

16 เม่ือผูใ้ชง้านสร้างเงินยมื/เงินทดรอง ให้ท  าการส่งรายการขอ้มูลจาก Expense  Report โดยเขา้สู่เมนูหนา้จอ 

View>Request เลือกช่ือ Request เป็น Expense Report Import 

   

17 ก่อนท าการส่งขอ้มูลจากระบบเจา้หน้ีไปยงัระบบบญัชีแยกประเภททัว่ไป ให้ท  าการพิมพร์ายงาน 

Payables Accounting Analyst Report  เพื่อตรวจสอบความถูกตอ้ง 

   

18 การส่งขอ้มูลรายการบญัชีจากระบบบญัชีเจา้หน้ีไปยงัระบบสินทรัพยถ์าวรให้เขา้สู่หนา้จอเมนู View 

Request แลว้เลือกช่ือ Concurrent  เป็น Mass Additions Create 

   

19 ก่อนท าการปิดงวดบญัชี ท่ีระบบบญัชีเจา้หน้ี ตอ้งตรวจสอบว่ามีขอ้มูลท่ียงัไม่ได ้Post ไปยงั 

บญัชีแยกประเภททัว่ไปหรือไม่ โดยการ Run Report ท่ีช่ือ Unaccounted Transactions Report  

   

20 เม่ือตอ้งการพิมพร์ายงานให้เขา้สู่หนา้จอเมนู View Request    
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ข้อ 
5. ระบบสินทรัพย์ถาวร ใช่ ไม่ 

ใช่ 

ไม่

แน่ใจ 

1 เม่ือเตรียมขอ้มูลครุภณัฑท่ี์รับมาจากระบบบญัชีเจา้หน้ีพร้อมแลว้ ตอ้ง Run program  

ช่ือ Prepare Mass Addition  เพ่ือข้ึนทะเบียนครุภณัฑ ์

   

2 การเตรียมขอ้มูลครุภณัฑท่ี์ไดจ้ากระบบบญัชีเจา้หน้ี ตอ้งเปล่ียน Queue เป็น New เสมอ    

3 ถา้ครุภณัฑมี์จ านวนมากกวา่ 1 ช้ิน ใหแ้ยกบนัทึกรับครุภณัฑ ์โดยกดปุ่ ม (Split)    

4 การข้ึนทะเบียนครุภณัฑแ์บบเตม็รูปแบบ ตอ้งเขา้สู่หนา้จอ Asset Workbench    

5 เม่ือตอ้งการข้ึนทะเบียนครุภณัฑแ์บบเร่งด่วนให้ใชห้นา้จอ Additions และ Quick Additions    

6 การรับขอ้มูลครุภณัฑง์านระหวา่งก่อสร้าง ไม่ตอ้งเปล่ียนสถานะ Asset type แต่อยา่งใด    

7 การเปล่ียนแปลงขอ้มูลกลุ่มครุภณัฑท่ี์ข้ึนทะเบียนแลว้ ตอ้งกดปุ่ ม Additions ท่ีหนา้ทะเบียน

ครุภณัฑ ์

   

8 การเปล่ียนแปลงขอ้มูลทางการเงินตอ้งครุภณัฑท่ี์ข้ึนทะเบียนแลว้ตอ้งกดปุ่ ม Books ท่ีหนา้

ทะเบียนครุภณัฑ ์

   

9 เม่ือผูใ้ชง้านพบขอ้ผิดพลาดในการบนัทึกครุภณัฑ ์ผูใ้ชง้านสามารถเปล่ียนแปลง แกไ้ข 

เปล่ียนกลุ่มครุภณัฑ ์ไดโ้ดยไม่ตอ้งไดรั้บอนุมติัจากหวัหนา้งาน 

   

10 การโอนยา้ยทรัพยสิ์นท่ีข้ึนทะเบียนแลว้ ตอ้งกดปุ่ ม Open ท่ีหนา้ทะเบียนครุภณัฑ ์    

11 ถา้ตอ้งการจ าหน่ายครุภณัฑต์อ้งกดปุ่ ม Retirement ในหนา้จอทะเบียนครุภณัฑ ์    

12 รายงาน Asset Inventory เป็นรายงานสรุปครุภณัฑข์องแต่ละหน่วยงาน ใชใ้นการส ารวจ 

ตรวจนบัครุภณัฑ ์

   

13 การคิดค่าเส่ือมราคาตอ้งเขา้เมนู Assets>Asset Workbench    

14 ในหนา้จอ Run Depreciation ถา้เลือก Close Period แลว้จะท าให้ไม่สามารถคิดค่าเส่ือมราคา

สินทรัพยน์ั้นได ้

   

15 การยกเลิกการคิดค่าเส่ือมราคาตอ้งเขา้เมนู Depreciation>Run Depreciation    
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ข้อ 
6. ระบบบัญชีแยกประเภททัว่ไป ใช่ ไม่ 

ใช่ 

ไม่

แน่ใจ 

1 หากตอ้งการสร้างรายการบญัชี เม่ือเขา้สู่ระบบท่ีหนา้จอ Find Journal แลว้ ตอ้งกดปุ่ ม New Journal    

2 Effective Date  เป็นวนัท่ีลงรายการบญัชี    

3 ผูใ้ชส้ามารถดูรายการบนัทึกบญัชีแบบ T-Account  ไดโ้ดยกดปุ่ ม T Account    

4 เม่ือสร้างรายการบญัชีแลว้ จะตอ้งก าหนดเลขท่ีใบส าคญัให้ระบบ ก่อนจึงจะสามารถบนัทึกขอ้มูล 

(Save)ได ้

   

5 ผูใ้ชง้านไม่สามารถระบุรายละเอียด (Parameters) ส าหรับคน้หารายการบญัชีแบบ Actual, Budget 

และ Encumbrance ในระบบได ้

   

6 การผา่นรายการบญัชี (Posting) สามารถท าไดวิ้ธีเดียว คือ การผา่นรายการบญัชีโดยตรงท่ีเมนู Post    

7 ระบบจะไม่อนุญาตให้ผา่นรายการบญัชี (Posting) ถา้ไม่ไดท้  ารายการจองงบประมาณ    

8 รายการท่ีผ่านรายการ (Post) แลว้สามารถท ารายการปรับปรุงได้    

9 หลงัจากกลบัรายการบญัชีแลว้ ระบบจะสร้างรายการบญัชีให้ใหม่ ซ่ึงจะมีสถานะของรายการ (Batch 

Status) เป็น Posted 

   

10 การส่งขอ้มูลจากระบบบญัชีเจา้หน้ี ผูใ้ชง้านสามารถใช ้Request Expense ในการส่งขอ้มูลรายการ

บญัชีมาท่ีระบบบญัชีแยกประเภททัว่ไป 

   

11 กรณีรายการบญัชีท่ีส่งมาจากระบบยอ่ยไม่ถูกตอ้ง ผูใ้ชง้านในระบบบญัชีแยกประเภททัว่ไปไม่

สามารถแกไ้ขรายการทางบญัชีท่ีส่งมาจากระบบยอ่ยนั้นได ้ 

   

12 ก่อนท าการเปิดงวดบญัชี จะตอ้งสร้างรอบระยะเวลาบญัชีในระบบก่อน    

13 ก่อนท าการปิดปีบญัชี ตอ้งท าการตรวจสอบการท ารายการในระบบวา่มีการรับขอ้มูลรายการบญัชีจาก

ระบบบญัชียอ่ยทุกระบบ โดยไม่ตอ้งตรวจสอบความถูกตอ้งเน่ืองจากระบบมีการค านวณรายการท่ี

ถูกตอ้ง เช่ือถือได ้

   

14 เม่ือตอ้งการพิมพร์ายงานให้เขา้สู่เมนู View>Request แลว้ระบุเง่ือนไขท่ีตอ้งการในหนา้จอ Parameter     
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ขอ้ 
7. ระบบบริหารคลงัวสัดุ ใช่ ไม่ 

ใช่ 

ไม่

แน่ใจ 

1 หากผูใ้ชง้านตอ้งการสร้างขอ้มูลพสัดุใหม่ ตอ้งเลือกเมนูหนา้ต่าง Master Items    

2 ถา้ตอ้งการเลิกใชง้านรายการพสัดุ จะตอ้งท าการก าหนดค่าท่ีช่อง Item Status  เป็น Inactive    

3 ในการก าหนดรหสัประเภทพสัดุ ผูใ้ชง้านตอ้งสร้างชุดขอ้มูลกลุ่มพสัดุข้ึนมาก่อน    

4 ในขั้นตอนการสร้างรหสักลุ่มประเภทพสัดุ ผูใ้ชง้านกดปุ่ ม Assign เพื่อคน้หาประเภทกลุ่ม

พสัดุ 

   

5 ผูใ้ชง้านสามารถก าหนดอตัราการแปลงหน่วยนบั (UOM conversion) ได ้    

6  เม่ือผูใ้ชง้านปิด Period ในระบบแลว้จะท าให้ไม่สามารถท างานใน Period นั้นได ้    

7  ผูใ้ชง้านมีสิทธิในการใชค้ลงัพสัดุมากกวา่ 1 แห่ง ถึงจะมีสิทธิเลือกคลงัพสัดุในการท างาน    

8 หนา้จอส าหรับเปล่ียนคลงัพสัดุ คือ Change Inventory Organization    

9 การรับพสัดุแบบมาจากใบสัง่ซ้ือสั่งจา้งท่ีผูใ้ชง้านสามารถระบุราคาต่อหน่วย (Unit cost) ของ

พสัดุท่ีรับเองได ้

   

10 การน าส่งสินคา้และบริการจะผา่นขั้นตอนการตรวจรับสินคา้และบริการ ( Receipts)  แลว้

หรือไม่ก็ได ้

   

11 การรับพสัดุในระบบ มี 2 ประเภท ไดแ้ก่ การรับพสัดุท่ีมาจากใบสัง่ซ้ือสัง่จา้ง และการรับ

พสัดุท่ีมาไม่มีใบสัง่ซ้ือสัง่จา้ง 

   

12 ผูใ้ชง้านสามารถเขา้สู่หนา้จอ Transaction Receiving Returns  เพ่ือบนัทึกรายการส่งคืนสินคา้    

13 ผูใ้ชง้านสามารถเขา้สู่หนา้ต่างการบนัทึกการเบิกจ่ายวสัดุจากคลงัไดท่ี้เมนู Micellaneous 

Transaction 

   

14 ในการบนัทึกการเบิกจ่ายวสัดุจากคลงั ผูใ้ชง้านจ าเป็นตอ้งระบุวนัท่ีท  ารายการ เลขท่ีใบเบิก

วสัดุ  เพื่อท ารายการ 

   

15 ผูใ้ชง้านสามารถบนัทึกการโอนยา้ยวสัดุระหวา่งคลงัไดท่ี้หนา้จอเมนู Sub inventory Transfer    

16 การบนัทึกโอนยา้ยวสัดุท าไดค้ร้ังละ 1 รายการ    

17 การตรวจสอบวสัดุคงเหลือจะสามารถท าไดต้อนส้ินปีงบประมาณเพียงคร้ังเดียว    

18 การปรับปรุงเปล่ียนแปลงรายการบญัชีพสัดุสามารถท าไดโ้ดยไม่ตอ้งไดรั้บอนุมติัจากผูมี้

อ  านาจอนุมติั 

   

19 หนา้จอเมนู Material Transactions ใชก้ารตรวจสอบประวติัการท ารายการพสัดุ    

20 การตรวจสอบการท ารายการแต่ละประเภท ผูใ้ชง้านจะตอ้งระบุเง่ือนไขของประเภทการท า

รายการ (ประเภทพสัดุ) ท่ีช่อง Item 

   

21 ขอ้มูลท่ีแสดงในรายงานใบตรวจรับพสัดุเป็นขอ้มูลจากรายการสั่งซ้ือสั่งจา้งเท่านั้น    

22 ขอ้มูลท่ีแสดงในรายงานใบเบิกพสัดุเป็นขอ้มูลจากรายการสัง่ซ้ือสัง่จา้งเท่านั้น    

23 Sub inventory quantities report  เป็นรายงานแสดงจ านวนวสัดุในคลงัยอ่ยๆ ของแต่ละเขต

พ้ืนท่ี 
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ขอ้ 
8. ระบบกระแสเงนิสด ใช่ ไม่ 

ใช่ 

ไม่

แน่ใจ 

1 การพิมพร์ายงานจากระบบให้เขา้สู่เมนู View>Request    

2 เม่ือระบบประมวลผลเสร็จสถานะ Phase = Pending, Status= Normal    

3 การก าหนดเง่ือนไขท่ีตอ้งการให้แสดงรายละเอียดในรายการ ให้ก  าหนดท่ีหนา้จอ  

Parameter  ซ่ึงรายละเอียดในแต่ละรายการจะแตกต่างกนั 

   

4 Cash Forecast Report  เป็นรายงานท่ีแสดงรายการประมาณการเงินสด    

5 Cash Forecast  Execution Report  เป็นรายงานท่ีแสดงขอ้ผิดพลาดท่ีเกิดข้ึน จากการ

สร้างรายงานประมาณการกระแสเงินสด 

   

6 General Ledger Reconciliation Report  เป็นรายงานส าหรับตรวจสอบรายการ    

7 Cash In Transit Report เป็นรายงานท่ีแสดง Transaction ทั้งหมดท่ีเก่ียวกบับญัชีธนาคาร

นั้นๆ 

   

 

 

ขอ้ 
9.ระบบรายงานผู้บริหาร ใช่ ไม่ 

ใช่ 

ไม่

แน่ใจ 

1 การเขา้ใชง้านในระบบรายงานผูบ้ริหาร (ระบบ FI) ให้เขา้ผา่นเวบ็บราวเซอร์ โดยป้อน 

Address http://erp.rmutl.ac.th 

   

2 หากท่านตอ้งการปรับวางต าแหน่งของรายงานให้เหมาะสมตามท่ีตอ้งการ ระบบมีการ

ออกแบบไม่ให้ท่านสามารถท าไดด้ว้ยตนเอง 

   

3 ความถ่ีในการปรับขอ้มูล(Update)ระบบรายงานผูบ้ริหาร จะท าทุกวนั วนัละ 1 คร้ัง 

ในช่วงเวลากลางคืน 

   

4 การสร้างรายงานเบ้ืองตน้ ให้คลิกท่ี Answers ท่ีแถบเมนู และไอคอน RMUTL    

5 
ไอคอน   ในหนา้จอ Answers เป็นปุ่ มเรียงล าดบัขอ้มูล ใชส้ าหรับเรียงล าดบัจาก

นอ้ยไปมาก หรือจากมากไปน้อย 

   

6 
ไอคอน ในหนา้จอ Answers เป็นปุ่ มแกไ้ขสูตร ใชใ้นการค านวณค่าทาง

คณิตศาสตร์ 

   

7 
ไอคอน ในหนา้จอ Answers ปุ่ มเพ่ิมฟิลเตอร์ ใชใ้นการกรองขอ้มูลให้แสดง

ในทางคณิตศาสตร์เท่านั้น 

   

8 ตารางเปล่ียนจุดอา้งอิง(Pivot Table) เป็นหนา้จอท่ีใชส้ าหรับสร้างรายงาน มีความ

ยดืหยุน่สูง สามารถจดัเรียงขอ้มูลไดห้ลากหลาย ง่ายต่อการอ่านและท าความเขา้ใจ 
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ส่วนที ่3  ขอ้มูลเก่ียวกบัปัญหาและขอ้เสนอแนะเก่ียวกบัระบบวางแผนทรัพยากรองคก์ร                 

ค าช้ีแจง  โปรดท าเคร่ืองหมาย    ในช่องค าตอบท่ีตรงความคิดเห็นของท่าน 

 

ขอ้ ด้านการควบคุมทั่วไป 

ระดบัปัญหา ไม่มี

ปัญหา มาก

ท่ีสุด 

มาก ปาน

กลาง 

นอ้ย นอ้ย

ท่ีสุด 

1 คอมพิวเตอร์หรืออุปกรณ์ส าหรับใชง้านในระบบวางแผน

ทรัพยากรองคก์รไม่เพียงพอ 

      

2 การสนบัสนุนดา้นทรัพยากร (บุคคล งบประมาณ) ในการ

ปฏิบติังานในระบบวางแผนทรัพยากรองคก์รจากฝ่ายบริหารไม่

เพียงพอ 

      

3 ระบบเครือข่ายของระบบวางแผนทรัพยากรองคก์รชา้และ

ขดัขอ้งบ่อย 

      

4 ระบบวางแผนทรัพยากรองคก์รก าหนดจ านวนผูเ้ขา้ใชง้านใน

ระบบพร้อมกนั (Concurrent) จ ากดั ท  าให้ผูป้ฏิบติังานไม่

สามารถเขา้ใชง้านในระบบไดต้ามความตอ้งการ 

      

5 ผูป้ฏิบติังานไม่มีความรู้ดา้นคอมพิวเตอร์และไม่ได้รับการ

พฒันาความรู้ดา้นคอมพิวเตอร์อยา่งต่อเน่ือง 

      

6 ผูป้ฏิบติังานไม่ทราบเป้าหมายและประโยชน์ในการน าระบบ

วางแผนทรัพยากรองคก์รมาใชใ้นมหาวิทยาลยัฯ 

      

7 ผูป้ฏิบติังานในระบบวางแผนทรัพยากรองคก์ร มีเปล่ียนแปลง

บ่อยจากการโยกยา้ย หรือลาออกเน่ืองจากเป็นอตัราพนกังาน

ตามพนัธกิจ 

      

8 จ านวนคร้ังของการเขา้รับการอบรมเก่ียวกบัการปฏิบติังานใน

ระบบวางแผนทรัพยากรองคก์รนอ้ยคร้ัง ท าให้ขาดความรู้ความ

เขา้ใจในการปฏิบติังานในระบบ 

      

9 บุคลากรผูใ้ห้ค  าปรึกษาดา้นระบบวางแผนทรัพยากรองคก์รไม่

เพียงพอต่อความตอ้งการท าให้ไม่สามารถแกไ้ขปัญหาไดท้นัที 

      

10 คู่มือท่ีใชใ้นการปฏิบติังานในระบบไม่มีรายละเอียดเพียงพอท า

ให้ไม่สามารถน ามาใชเ้ป็นแนวทางในการปฏิบติังานจริงได้ 
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ข้อ ด้านการควบคุมระบบงาน 

ระดบัปัญหา ไม่มี

ปัญหา มาก

ที่สุด 

มาก ปาน

กลาง 

น้อย น้อย

ที่สุด 

ด้านการน าเข้าข้อมูล  

11 รูปแบบค าอธิบายของหนา้จอเป็นภาษาองักฤษท าให้การกรอก

ขอ้มูลเขา้ระบบมีความยุง่ยากมากข้ึน 

      

12 การน าเขา้ขอ้มูลตอ้งระบุโครงสร้างทางการบญัชี (10 มิติ)       

13 ความสามารถในการป้องกนัขอ้ผิดพลาดของระบบ เช่น การ

น าเขา้ขอ้มูล หากรายการจ านวนเงินดา้นเดบิตและดา้นเครดิตไม่

เท่ากนั ระบบจะไม่มีการแจง้เตือน เป็นตน้ 

      

ด้านการประมวลผล  

14 ระบบใชเ้วลาในการประมวลผลขอ้มูลค่อนขา้งนาน       

15 ความผิดพลาดในการประมวลผลของระบบ เช่น ระบบจะ

แสดงผลการค านวณเป็นจ านวนเตม็ หากค่าผลการค านวณเป็น

จ านวนทศนิยม ระบบจะปัดทศนิยมเป็นจ านวนเตม็โดยอตัโนมติั 

เป็นตน้ 

      

16 การแกไ้ขขอ้มูลรายการ ในกรณีท่ีมีการปิดงวดบญัชี (Period) แลว้ 

ท าไดย้าก 

      

ด้านผลลพัธ์  

17 รูปแบบรายงานท่ีไดจ้ากระบบมีรายละเอียดท่ีตรวจสอบความ

ถูกตอ้งไดย้าก 

      

18 รายงานท่ีไดจ้ากระบบไม่สามารถน าไปสอบทานความถูกตอ้ง

โดยเปรียบเทียบกบัจากรายงานจากระบบ GFMIS ได ้ 

      

19 การก าหนดสิทธิในการเขา้ดูรายงานจากระบบวางแผนทรัพยากร

องคก์รแตกต่างกนัตามระบบงานยอ่ย ท าให้ผูป้ฏิบติังานไม่

สามารถเรียกรายงานท่ีตอ้งการจากระบบงานยอ่ยอ่ืนมาเพ่ือ

ตรวจสอบร่วมกบัรายงานจากระบบงานยอ่ยท่ีตนเองมีสิทธิได ้

      

 

 

 

 
ขอขอบพระคุณท่านท่ีกรุณาเสียสละเวลาในการตอบแบบสอบถาม 

 

ข้อเสนอแนะ 

…………………………………………………………………………………………………………………………………………………… 

………………………………………………………………………………………………………………………………………………….. 

………………………………………………………………………………………………………………………………………………….. 
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ประวตัิผู้เขียน 

 

ช่ือ-สกุล     นางสาวขวญัเรือน  พิศเพง็ 

 

วนั เดือน ปี เกดิ    26 สิงหาคม 2520 

 

ประวตัิการศึกษา    

2541   ประกาศนียบตัรวชิาชีพชั้นสูง (การบญัชี) 

     โรงเรียนเทคโนโลยปีทุมธานี  

   

2544   บริหารธุรกิจบณัฑิต (การบญัชี)  

สถาบนัเทคโนโลยรีาชมงคล 

 

ประวตัิการท างาน   

2540   เจา้หนา้ท่ีการเงินและบญัชี 

     คณะคหกรรมศาสตร์ สถาบนัเทคโนโลยรีาชมงคล 
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